Disclaimer of Warranty and Liability

MESO SCALE DIAGNOSTICS, LLC. ("MSD") MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND, AND HEREBY EXPRESSLY EXCLUDES AND DISCLAIMS ANY AND ALL REPRESENTATIONS AND WARRANTIES WITH REGARD TO THIS INSTRUMENT MANUAL (THIS “MANUAL”), INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY, SUITABILITY OR FITNESS FOR A PARTICULAR PURPOSE, DATA ACCURACY, SYSTEM INTEGRATION, QUIET TITLE OR NONINFRINGEMENT. NO STATEMENT IN THIS MANUAL SHALL BE INTERPRETED TO GRANT OR EXTEND ANY WARRANTY ON THE PRODUCTS DESCRIBED HEREIN. MSD SHALL NOT BE LIABLE FOR ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR ANY DAMAGES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE, WHETHER ARISING IN CONTRACT, TORT, STRICT LIABILITY OR OTHERWISE, THAT MAY BE INCURRED IN CONNECTION WITH THE FURNISHING, PERFORMANCE OR USE OF THIS MANUAL.

Changes in Publication

The information contained in this Manual is subject to change without notice.

Unauthorized Use of Manual Material

No part of this Manual may be duplicated, reproduced, stored in a retrieval system, translated, transcribed, or transmitted in any form or by any means without the express prior written permission of MSD. This Manual shall be returned to MSD within two (2) business days following any request by MSD.

Unauthorized Use of Trademarks or Service Marks

MESO SCALE DISCOVERY, MESO SCALE DIAGNOSTICS, MSD, MSD GOLD, DISCOVERY WORKBENCH, MULTI-ARRAY, MULTI-SPOT, QUICKPLEX, SECTOR, SECTOR PR, SECTOR HTS, SULFO-TAG, R-PLEX, S-PLEX, U-PLEX, V-PLEX, STREPTAVIDIN GOLD, MESO, www.mesoscale.com, SMALL SPOT (design), 96 WELL 1, 4, 7, 9, & 10-SPOT (designs), 384 WELL 1 & 4-SPOT (designs), MSD (design), R-PLEX (design), S-PLEX (design), U-PLEX (design), V-PLEX (design), It's All About U, and SPOT THE DIFFERENCE are trademarks and/or service marks of Meso Scale Diagnostics, LLC.

All other trademarks or service marks are the property of their respective owners.

© 2013, 2017 Meso Scale Diagnostics, LLC. All rights reserved.
# Table of Contents

1 Introduction .......................................................................................................................... 7  
1.1 Intended Audience ............................................................................................................ 7  
1.2 How to Use This Manual ................................................................................................. 7  
1.3 Warnings and Caution Symbols ....................................................................................... 8  
1.4 Formatting Information ................................................................................................. 8  

2 Safety Information .............................................................................................................. 10  
2.1 Regulatory and Safety Certifications ................................................................................ 10  
   2.1.1 WEEE Compliance .................................................................................................... 10  
   2.1.2 Hazardous Substances ............................................................................................. 11  
2.2 Symbols and Labels ......................................................................................................... 11  
2.3 General Operation .......................................................................................................... 13  
2.4 Hazards ............................................................................................................................ 13  
   2.4.1 Electrical .................................................................................................................. 14  
   2.4.2 Chemical and Biological ......................................................................................... 15  
   2.4.3 Mechanical .............................................................................................................. 16  
   2.4.4 ESD Sensitivity ......................................................................................................... 17  
   2.4.5 Electromagnetic Interference and Susceptibility ..................................................... 17  
2.5 Software Compatibility ................................................................................................... 17  
2.6 Decontamination Prior to Shipping or Servicing ............................................................. 18  

3 System Description ............................................................................................................. 20  
3.1 Intended Use .................................................................................................................... 20  
3.2 Specifications Overview .................................................................................................. 20  
3.3 Plate Compatibility ......................................................................................................... 20  
3.4 System Components ....................................................................................................... 20  
3.5 The SECTOR S 600 Instrument ....................................................................................... 21  
   3.5.1 CCD Camera and Telecentric Lens ......................................................................... 22  
   3.5.2 Motion Control System ......................................................................................... 22  
   3.5.3 Plate Barcode Readers ............................................................................................ 22  
   3.5.4 MULTI-ARRAY Plate Input/Output Stacker ............................................................. 23  
   3.5.5 Stack Tubes ............................................................................................................. 23  
   3.5.6 Single Plate Adapter ............................................................................................... 25  
   3.5.7 Stacker Cover Plate ............................................................................................... 25  
   3.5.8 Status LEDs ........................................................................................................... 26  
   3.5.9 Power Switch and Input/Output (I/O) Panel ........................................................... 27  
   3.5.10 Halt Button (on some configurations) .................................................................. 28  
3.6 Microsoft Windows-Compatible Workstations ............................................................... 29  
3.7 MSD DISCOVERY WORKBENCH Software ................................................................ 29  
3.8 Operational Modes ........................................................................................................ 30  
3.9 Image Readout ................................................................................................................. 30  
3.10 M burry SECTOR Demonstration Plate .......................................................................... 31  
3.11 Uninterruptible Power Supply ...................................................................................... 32  

4 Installation .......................................................................................................................... 34  
4.1 Quick Start ....................................................................................................................... 36  
   5.1 Start-up ......................................................................................................................... 37  
   5.2 Setup ............................................................................................................................. 38
5.3 Run ......................................................................................................................... 40
  5.3.1 Operations ......................................................................................................... 41
5.4 Results .................................................................................................................... 42
6 Using the SECTOR S 600 ......................................................................................... 44
  6.1 Single Plate Run .................................................................................................... 44
  6.2 Stack Run—Multiple Plates ................................................................................... 44
    6.2.1 Loading the Stack Tube ................................................................................... 44
    6.2.2 Unloading the Stack Tube ............................................................................... 46
  6.3 Robotics Integration ............................................................................................... 46
7 Maintenance ............................................................................................................... 48
  7.1 Preventive Maintenance ....................................................................................... 48
  7.2 Instrument Cleaning ............................................................................................. 48
    7.2.1 Adapter and Stack Tube Cleaning .................................................................... 49
  7.3 Instrument Decontamination ................................................................................ 49
8 Appendix ................................................................................................................... 51
  8.1 Troubleshooting Guide ......................................................................................... 51
  8.2 Specifications ....................................................................................................... 54
    8.2.1 SECTOR S 600 ............................................................................................... 54
    8.2.2 Scientific Performance .................................................................................... 54
    8.2.3 Environmental Specifications ......................................................................... 54
    8.2.4 Power Requirements ...................................................................................... 54
    8.2.5 SECTOR S 600 Physical Dimensions .............................................................. 55
    8.2.6 Plate Standard Read Volume (per Well) ......................................................... 55
    8.2.7 Custom Bar Code Compatibility* .................................................................... 55
    8.2.8 Plate Specifications ......................................................................................... 55
9 Technical Support ...................................................................................................... 57
  9.1 Bug Reports and Suggestions .............................................................................. 57
  9.2 Problems Running SECTOR S 600 Instruments .................................................. 57
  9.3 How to Contact Us ............................................................................................... 57
List of Figures

Figure 2:1 SECTOR S 600 electrical hazards ................................................................. 14
Figure 3:1 SECTOR S 600 system .................................................................................. 21
Figure 3:2 SECTOR S 600 components ......................................................................... 22
Figure 3:3 Custom Barcode Reader Selection Dialog ..................................................... 23
Figure 3:4 Input (right) stacker interface plate ............................................................... 24
Figure 3:5 Fully loaded standard and high capacity stack tubes ..................................... 24
Figure 3:6 SECTOR plate in single plate adapter ............................................................ 25
Figure 3:7 SECTOR S 600 status LEDs .......................................................................... 26
Figure 3:8 Power switch and I/O panel ........................................................................... 27
Figure 3:9 SECTOR S 600 halt button (on some configurations) ...................................... 28
Figure 3:10 Cable attachment locations for SECTOR S 600 ........................................... 29
Figure 3:11 The SECTOR S 600 reads 96-well plates in six sectors .............................. 30
Figure 3:12 Meso SECTOR Demonstration Plate ............................................................ 31
Figure 3:13 Loading a demonstration plate .................................................................... 32
Figure 5:1 Instrument Status window ............................................................................ 36
Figure 5:2 MSD DISCOVERY WORKBENCH desktop icon ............................................. 37
Figure 5:3 SECTOR S 600 icon ....................................................................................... 37
Figure 5:4: MSD DISCOVERY WORKBENCH splash screen ....................................... 38
Figure 5:5 SECTOR S 600 Window: Setup, Plate Summary, and Operations areas .......... 39
Figure 5:6 Stacker cover over the output port with empty single plate adapter in the input port ................................................................. 39
Figure 5:7 Meso SECTOR demonstration plate in the single plate adapter ................. 40
Figure 5:8 SECTOR S 600 window, Run Options dialog box ......................................... 41
Figure 5:9 Demonstration plate results, Color Map layer ................................................ 42
Figure 6:1 Loading MULTI-ARRAY plates into stack tube ............................................. 45

List of Tables

Table 2:1 Hazardous Substances ...................................................................................... 11
Table 2:2 Symbols and labels ........................................................................................ 11
Table 3:1 Stack tube plate capacities ............................................................................ 23
Table 8:1 Troubleshooting guide ................................................................................... 51
Table 8:2 Scientific performance ................................................................................... 54
Introduction
Meso Scale Discovery (MSD) develops, manufactures, and markets biological assays that provide cost-effective and valuable information to scientists in drug discovery, therapeutic screening, and life science research. MSD’s product portfolio is based on Multi-Array® technology, a proprietary combination of patterned arrays and electrochemiluminescence detection that results in exceptional sensitivity, speed, dynamic range, and convenience.

MSD develops, manufactures, and markets detection instrument systems as well as a line of assay kits for use with these instruments, a proprietary line of reagents, and custom microplate printing and assay development services. MSD® Multi-Array microplates are available in 96- and 384-well formats with standard or high-binding surfaces. MSD plates may be purchased uncoated or coated with proteins such as streptavidin or avidin, with anti-species antibodies such as goat anti-mouse or goat anti-rabbit, or with antibodies against specific analytes. Custom coatings and surface treatments are available.

MSD Multi-Array plates are available as single spot (single assay) plates and as Multi-Spot™ plates with patterned spot arrays in each well. Multi-Spot plates measure multiple analytes simultaneously in a single well, increasing throughput and enabling novel assay panels.

For more details and information about applications, please visit the MSD website at www.mesoscale.com.

1.1 Intended Audience
This manual is for all users of the Meso Sector® S 600 instrument. Users should understand general computer and Microsoft Windows terminology, and be familiar with standard laboratory practices. The intended users of the Sector S 600 are those conducting research in the life sciences.

This manual describes how to operate the Sector S 600 and acquire data using Sector Multi-Array and Multi-Spot plates. The analysis of this data is treated in a separate manual: Discovery Workbench® User’s Guide.

1.2 How to Use This Manual
This manual is organized by chapters containing main topics and subsections. Use the hyperlinked Table of Contents to find topics of interest quickly. The List of Figures and List of Tables hyperlink to the images and tables that enhance understanding of written information in this manual. The Appendix contains supplemental information on troubleshooting, instrument specifications, safety symbols, regulatory information, and labels.

Tips

Symbol

Tips provide extra information or details that help users perform functions more efficiently.

Notes

Notes provide supplemental information on the proper use of the Sector S 600 and its software.
1.3 Warnings and Caution Symbols

**WARNING**

General warnings advise operators of potential hazards and highlight the procedures or information necessary to avoid personal injury during use of the SECTOR S 600.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Risk exists for a mechanical, chemical, or safety hazard</td>
</tr>
<tr>
<td>!</td>
<td>Risk exists for an electrical hazard</td>
</tr>
<tr>
<td></td>
<td>Risk of exposure to biohazards</td>
</tr>
</tbody>
</table>

**CAUTION**

A caution note highlights procedures or information necessary to avoid damage to equipment, corruption of software, loss of data, or invalid test results.

⚠️ **CAUTION:** Carefully read and understand all information in this document. Failure to read, understand, and follow the instructions in this publication may result in damage to the product, injury to operating personnel or poor instrument performance.

1.4 Formatting Information

This guide uses the following formatting conventions:

- Internal hyperlinks are formatted **bold/gray**. Click to jump instantly to the referenced section or figure.
- External hyperlinks are formatted **underlined/blue**. Click to create an email message or open an external web page.
- Clickstreams are indicated with arrows and always start with a top-level menu item: Select Tools ➔ Plate Data History.
- Information to be entered by the user is shown in italics: Enter *Administrator*
- When referring to a term as it appears in the software, we capitalize it exactly as it is capitalized on-screen: Select Read from Bar Code from the Plate Type menu.
Safety Information
2 Safety Information

2.1 Regulatory and Safety Certifications

The SECTOR S 600 has been tested to comply with applicable regulatory standards; it carries the cSGSus mark and is CE marked.

Regarding EN 61326-1: 2013 Electrical Equipment for Measurement, Control, and Laboratory Use – EMC Requirements:

- The SECTOR S 600 imager is designed for operation in a controlled electromagnetic environment. Transmitters of RF energy such as mobile (cellular) telephones should not be used in close proximity.

Regarding FCC Rules, Part 15, Subpart B, as a Class A digital device:

- This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. The equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with this user manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case, users will be required to correct the interference at their own expense.

Regarding Industry Canada Interference-Causing Equipment Standard:

- This Class A digital apparatus complies with CAN ICES-001(A).
- Cet appareil numérique de la Classe A est conforme à la norme NMB-001(A) du Canada.

Contact MSD Scientific Support with inquiries about the regulatory compliance of MSD instrumentation.

2.1.1 WEEE Compliance

The MESO SECTOR S 600 was placed on the market after 2005 in compliance with European Union (EU) directive 2012/19/EU, the Waste Electrical and Electronic Equipment (WEEE) Directive.

For all inquiries regarding recycling of shipping materials and instrument disposal, contact MSD Instrument Service.
2.1.2 Hazardous Substances

In accordance with People's Republic of China Order No. 32 of the Ministry of Industry and Information Technology (Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic Products), MSD has designated an environmental protection use period of 50 years for the MESO SECTOR S 600 instrument when used under normal operating conditions. Table 2:1 indicates parts containing hazardous substances.

<table>
<thead>
<tr>
<th>Part Name</th>
<th>Lead (Pb)</th>
<th>Mercury (Hg)</th>
<th>Cadmium (Cd)</th>
<th>Hexavalent Chromium (Cr (VI))</th>
<th>Polybrominated Biphenyls (PBB)</th>
<th>Polybrominated Diphenyl Ethers (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Control System</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Plate Contact Mechanism</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Plate Stacker Assembly</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Main Control Board</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Cable Assemblies</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Printed Circuit Boards</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Camera</td>
<td>0</td>
<td>0</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

This table was prepared in accordance with the provisions of SJ/T 11364.

O: Indicates that said hazardous substance contained in all of the homogeneous materials for this part is below the limit requirement of GB/T 26572.
X: Indicates that said hazardous substance contained in at least one of the homogeneous materials used for this part is above the limit requirement of GB/T 26572.

2.2 Symbols and Labels

Table 2:2 defines the symbols found in this manual, on the instrument, and on the instrument labels.

<table>
<thead>
<tr>
<th>Symbol/Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="WARNING" /></td>
<td>Warning messages are highlighted with this symbol and the word WARNING in red. They advise operators of potential mechanical or other hazards and highlight the procedures or information necessary to avoid personal injury.</td>
</tr>
<tr>
<td><img src="image" alt="CAUTION" /></td>
<td>Caution messages are highlighted with this symbol and the word CAUTION in red. They highlight procedures or information necessary to avoid damage to equipment, corruption of software, loss of data, or invalid test results.</td>
</tr>
<tr>
<td><img src="image" alt="This symbol indicates a potential electrical hazard" /></td>
<td>This warning symbol indicates a potential electrical hazard. This device contains high voltage. Disconnect the device from its power source before changing a fuse, moving the device, or connecting/disconnecting any cable.</td>
</tr>
<tr>
<td><img src="image" alt="These symbols indicate a risk of exposure to biohazards" /></td>
<td>These symbols indicate a risk of exposure to biohazards. Ensure surfaces are decontaminated and cleaned and proper personal protective equipment is worn to prevent exposure.</td>
</tr>
<tr>
<td><img src="image" alt="This warning symbol indicates a pinch hazard exists" /></td>
<td>This warning symbol indicates a pinch hazard exists. Keep fingers and loose clothing away from moving parts. Unplug the power cord before putting hands near parts labelled with this warning.</td>
</tr>
<tr>
<td><img src="image" alt="These symbols indicate the presence of a rated fuse" /></td>
<td>These symbols indicate the presence of a rated fuse. Electrical fuses should only be accessed by MSD Service Engineers.</td>
</tr>
<tr>
<td><img src="image" alt="This warning indicates this instrument is an Electrostatic Sensitive Device" /></td>
<td>This warning indicates this instrument is an Electrostatic Sensitive Device. The SECTOR S 600 is sensitive to static discharge in excess of 4.0 kV.</td>
</tr>
<tr>
<td>Symbol/Label</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>V</td>
<td>This symbol indicates a measurement or requirement in Volts.</td>
</tr>
<tr>
<td>A</td>
<td>This symbol indicates a measurement or requirement in Amperes, often referred to as Amps.</td>
</tr>
<tr>
<td>~</td>
<td>This symbol indicates electric current is in the form of alternating current (AC).</td>
</tr>
<tr>
<td>I</td>
<td>This symbol indicates placing a toggle switch in this position will place the instrument in a powered on state.</td>
</tr>
<tr>
<td>O</td>
<td>This symbol indicates placing a toggle switch in this position will place the instrument in a powered off state.</td>
</tr>
<tr>
<td>USB</td>
<td>This symbol marks the location of the plate motion halt button. The plate motion system will be halted if this button, which is located on the left side of the instrument, is pressed. It is an on/off button and must be pressed a second time to allow the plate motion system to function again.</td>
</tr>
<tr>
<td>USB</td>
<td>This symbol marks the location of the USB I/O Port on the instrument.</td>
</tr>
<tr>
<td>Yes</td>
<td>This symbol marks the location of the External Stop or Pause Control I/O Port.</td>
</tr>
<tr>
<td>CE</td>
<td>The European Conformity Marking indicates that the device complies with the essential requirements of the relevant European health, safety and environmental protection legislation, which includes compliance with the Restriction of Hazardous Substances (RoHS 2) directive.</td>
</tr>
<tr>
<td>WEEE</td>
<td>The WEEE symbol above a horizontal bar indicates this product was placed on the market after 2005 in compliance with European Union (EU) directive 2012/19/EU, the Waste Electrical and Electronic Equipment (WEEE) Directive.</td>
</tr>
<tr>
<td>SGS</td>
<td>The SGS System Certification Mark, or “Q-mark”, is issued by the Société Générale de Surveillance. It indicates this instrument has been tested by an accredited certification body for electromagnetic compatibility (EMC) and safety. This product is certified in the United States and Canada. The certification ID for Meso Scale Discovery is 800052. <a href="http://www.sgs.com/certifiedclients">http://www.sgs.com/certifiedclients</a>.</td>
</tr>
<tr>
<td>50</td>
<td>This logo is required by the China Ministry of Industry and Information Technology. It indicates the environmental protection use period of this instrument, in accordance with Order No. 32 (Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic Products). This product contains certain hazardous substances and under normal operating conditions can be used safely, without harm to the user or to the environment from these substances, for 50 years from the date of manufacture.</td>
</tr>
<tr>
<td>RCM</td>
<td>This Regulatory Compliance Mark (RCM) is required by the Australian Communications and Media Authority (ACMA). It indicates this instrument complies with all applicable ACMA regulatory arrangements and the instrument meets the regulatory requirements necessary for shipment to the Australian market.</td>
</tr>
</tbody>
</table>
2.3 General Operation

The SECTOR S 600 is designed to run continuously, 24 hours a day. Once initialized, the SECTOR S 600 enters standby mode when plates are not running. Standby maintains the CCD camera temperature. The SECTOR S 600 requires no additional initialization when left in standby mode.

⚠️ WARNING: The instrument can only be operated with all covers in place. If the unit is operated in any manner not specified in this manual, the protection provided by the equipment may be impaired.

⚠️ WARNING: Opening the instrument to perform maintenance incurs risk of mechanical, electrical, and laser harm.

⚠️ CAUTION: The instrument should be turned off and unplugged for all cleaning processes.

⚠️ CAUTION: Additional USB devices can interfere with SECTOR S 600 communication. Do not connect or disconnect USB devices while the SECTOR S 600 is in use.

⚠️ CAUTION: Changes to the computer clock can cause a system error if the changes are made during a plate read. A system error may also occur if a plate is being read when the time is automatically changed from standard to daylight savings time or vice versa.

NOTE: The SECTOR S 600 should be operated in a dust-free environment with an ambient temperature between 20–26°C, and humidity levels between 10–80% (non-condensing). Environments or locations with high levels of vibration should be avoided. See Section 8.2.3 Environmental Specifications for complete environmental specifications.

⚠️ CAUTION: Keep the SECTOR S 600 away from direct sources of heat or cold and direct sunlight. Ensure that the rear cooling vents and the CCD camera tower cooling vents on the SECTOR S 600 are not blocked.

⚠️ CAUTION: Do not place any objects, materials, or liquid containers on top of the SECTOR S 600.

⚠️ CAUTION: Falling objects or splashing liquids, including chemically reactive or infectious reagents, can cause damage to the instrumentation or cause injuries. Avoid handling or storing infectious or radioactive materials near the SECTOR S 600.

2.4 Hazards

This section contains notices and warnings that should be read carefully. Before working with the SECTOR S 600, become familiar with all safety precautions and regulations concerning the handling of materials and the instrument’s electrical and mechanical components.

Operating this device in a manner not specified by MESO SCALE DISCOVERY may impair the electrical and thermal protection provided by the equipment.

As with most laboratory instruments, the SECTOR S 600 presents certain hazards for users. We have identified five key types of hazards:

- Electrical
- Chemical and biological
- Mechanical
- ESD sensitivity
- Electromagnetic interference and susceptibility
2.4.1 Electrical

Do not attempt to open the instrument cover and work with any electronic elements. An electrical shock may occur. The SECTOR S 600 was designed and tested in compliance with appropriate electrical safety standards.

**WARNING:** The SECTOR S 600 contains AC voltages. **DO NOT ATTEMPT TO SERVICE OR REPAIR THE SECTOR S 600.** Please contact MSD Instrument Service for all service and repair, including electrical problems.

When the power switch is in the off position, all internal electrical circuits are disconnected from both the live and neutral lines of the electrical power source.

![Power Switch](image)

**WARNING:** The instrument must be located in a position where the rear power switch and power input connector are accessible.

**CAUTION:** Only mains power supply cords with a 10A or higher current rating can be used.

**WARNING:** For best performance, remove any sample or reagent spillage from the instrument. For safety, the operator should power down the instrument and disconnect the SECTOR S 600 power cable prior to cleaning near moving parts. For significant spills or liquid intrusion into the instrument enclosure (e.g. resulting from a fire protection water sprinkler), contact MSD Instrument Service.

The SECTOR S 600 should not be operated in hazardous atmospheres, as defined by the National Fire Protection Association, the National Electric Code, and International Standards.

Although the SECTOR S 600 is shielded and grounded, laboratory personnel should never remove any instrument covers that would expose electrical circuits. Only authorized MSD Service personnel should perform repairs to the interior of the SECTOR S 600.
NOTE: We strongly recommend that users of laboratory instruments (such as the SECTOR S 600) follow the Clinical and Laboratory Standards Institute (CLSI) document entitled GP17-A3, Clinical Laboratory Safety: Approved Guideline- Third Edition, Section 8.2, Electrical Equipment.

⚠️ CAUTION: Do not use a two-prong plug or extension cord to connect primary power to the SECTOR S 600. Use of a two-prong adapter disconnects utility ground, creating a shock hazard. Always connect the system power cord directly to a three-prong receptacle with a protective earth ground.

### 2.4.2 Chemical and Biological

Users are responsible for taking all necessary precautions against hazards associated with the use of laboratory chemicals. Running assays on the SECTOR S 600 may involve the use of potent chemicals—such as bases and solvents, cleaning and disinfection agents, and assay reagents. Such chemicals should be independently evaluated for chemical or biological hazards.

Laboratory regulations and good laboratory practices concerning the use of such chemicals should be followed at all times. Use personal protective equipment recommended by your facility when handling any of these reagents.

Product labels, package inserts and product information sheets with specific usage recommendations are provided for all plates and reagents used with the SECTOR S 600. Contact MSD Scientific Support to obtain safety data sheets (SDS) for MSD plates and reagents.

⚠️ WARNING: Samples, user reagents, or controls used in assays may be infectious or biohazardous. By working with these materials, users may be exposed to biological hazards. Laboratory regulations concerning the handling of potentially infectious material should be followed at all times.

⚠️ WARNING: Labels are affixed to the stack tube platforms indicating a potential chemical and biological hazard.

⚠️ WARNING: Users should avoid breathing reagent fumes. Gloves and goggles should be worn when disposing of used plates. If skin comes in contact with reagents, rinse the exposed area with water immediately, and follow appropriate safety protocols as determined by your facility. Dispose of used plates according to federal, state, and local regulations.

⚠️ WARNING: Wear appropriate personal protective equipment and avoid skin contact and inhalation when handling plates that contain or have been exposed to hazardous reagents.

⚠️ WARNING: The plate stacker input and output locations are considered susceptible to contamination during normal use. Use of personal protective equipment and good laboratory practices are strongly suggested when working in these areas.

⚠️ CAUTION: When reading multiple plates in a run, ensure that the stack tube is not overloaded. See Table 3:1 Stack Tube plate capacities.

⚠️ WARNING: Loading a tall stack of plates could lead to spilling potentially harmful chemical reagents. Use caution when loading the stack tubes.

⚠️ CAUTION: Not removing the completed plates from the output stack may cause spills if the number of completed plates exceeds the capacity of the output stack.
2.4.3 Mechanical

**WARNING:** The SECTOR S 600 weighs 124 lbs (56 kg). Be careful to use proper technique when lifting it to minimize the risk of injury. Two or more people should lift from beneath the instrument. Please contact MSD Instrument Service before attempting to move the instrument.

**WARNING:** The halt switch, located on the left side of the instrument, should never be obstructed or restricted from access.

**WARNING:** The SECTOR S 600 presents potential mechanical hazards. To avoid injury, do not touch any part of the instrument while it is in operation. Do not place fingers in stack tubes or the plate carrier when the instrument is in operation. Labels are affixed to the stack tube platforms indicating a pinch hazard.

**WARNING:** When the stack tubes are removed, the plate elevator and doors to the instrument pose a pinch hazard. Do not put hands into these regions while the instrument is powered-up.

**CAUTION:** When using robotic plate loaders (robots), ensure that there is nothing present that will obstruct robot movement.

**WARNING:** A stacker cover plate should always be in place when a stack tube or single plate adapter is not present. The stacker cover plate protects users from moving parts and protects the unused stacker area from dust and debris.

**WARNING:** Moving parts of the SECTOR S 600 can be damaged or become misaligned when exposed to strong mechanical force. As with any mechanical instrument, you should take certain precautions when operating the SECTOR S 600:

- Do not wear loose garments or jewelry that could catch in moving mechanisms.
- Operate the instrument with the cover intact.
- Keep hands away from pathways of moving parts during operation.
- Do not attempt mechanical repair.
- Do not bump into or lean on the SECTOR S 600, or place any objects on top of it.
- Never operate the instrument unless both stacker ports contain a single plate adapter (Figure 3:6), a stack tube (Figure 3:5), or the stacker cover plate (Figure 3:6).
2.4.4 ESD Sensitivity

The SECTOR S 600 has been tested for electrostatic discharge (ESD) sensitivity and complies with the applicable international standards. Standard installation precautions should be taken when stationing the instrument for regular use. Like many instruments of its kind, the SECTOR S 600 is sensitive to static discharge in excess of 4.0 kV. In typical laboratory environments, electrostatic discharge should not be a problem.

2.4.5 Electromagnetic Interference and Susceptibility

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. The equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause interference, in which case users will be required to correct the interference at their own expense.

Changes or modifications not expressly approved by MSD may void the warranty. The operator shall use any special accessories provided with the equipment such as the power supply or shielded cables that are necessary for compliance with FCC standards.

⚠️ CAUTION: The SECTOR S 600 instrument has been tested for operation in a controlled electromagnetic environment. Transmitters of RF energy such as mobile (cellular) telephones should not be used in close proximity.

⚠️ CAUTION: To avoid interference from electrical transients, plug the computer, monitor, and instrument into outlets on the same circuit. If an uninterruptible power supply (UPS) is available, plug the computer, monitor and instrument into the battery backup outlets. Please contact MSD Scientific Support if you have questions or need assistance.

2.5 Software Compatibility

The Microsoft Windows Update service can affect the operation of the instrument software. When running, the update application can turn off the database services upon which the instrument relies, causing errors and stopping instrument operation. Updates should not be run during instrument use. Run manually, or schedule Windows updates when you are sure that the instrument will not be in use.

Occasionally, Windows Update does not restart the database server after it runs. This will cause the instrument software to run incorrectly. Restarting the computer will restart the database server and restore the instrument to full operation.

The SECTOR S 600 system has not been tested for compatibility with all programs. Installation of additional applications, such as anti-virus and security programs, may interfere with function.

⚠️ CAUTION: Turn off automatic Windows and application update installation to prevent the system from automatically restarting while a run is in progress.

⚠️ CAUTION: Installation of additional software on the computer system used to operate the SECTOR S 600 is not supported. Specifically, updating aspects of the operating system or installing any software that changes parameters of the computer environment could interfere with proper operation of the instrument software.

⚠️ CAUTION: Running screen-savers, automated maintenance software, network-security software, and other software on the SECTOR S 600 computer system could cause conflicts with the operation of the instrument software.

⚠️ CAUTION: The instrument computer generates files when running. Virus scanning on the instrument computer can interfere with instrument operation. It is suggested that any virus checking software run on the instrument computer be configured to minimize the scanning of newly generated files while the instrument is operating.

⚠️ CAUTION: Use of other applications while plates are being read may interfere with system performance. Use of operating system power features that disable USB communication, such as Hibernate or Sleep, will cause the system to stop responding.
2.6 Decontamination Prior to Shipping or Servicing

The SECTOR S 600 may have been used to analyze infectious materials or in an environment where infectious materials were handled. For the protection of future users and service personnel, please follow site safety procedures and the directions of the site safety officer to disinfect the SECTOR S 600 before shipping or service. If shipping to MSD, contact MSD Instrument Service to determine the level of decontamination required.

⚠️ WARNING: Follow site safety procedures and the directions of the site safety officer to determine decontamination requirements for the imager before shipping or service.

⚠️ WARNING: Prior authorization must be obtained before the instrument and/or its accessories are shipped to MSD. Authorization is contingent upon completion of the MSD Instrument Decontamination Certification Form and issuance of a Returned Merchandise Authorization (RMA) number by MSD Instrument Service.
System Description
3 System Description

3.1 Intended Use
The SECTOR S 600 is for Research Use Only. The instrument is not for use in diagnostic procedures.

3.2 Specifications Overview
The SECTOR S 600 offers high sensitivity and six logs of dynamic range. The SECTOR S 600 instrument reads plates at a rate of approximately 70 seconds per plate. The DISCOVERY WORKBENCH software provides the capability to interact with a third party external robotic controller.

3.3 Plate Compatibility
The SECTOR S 600 is compatible with 96- and 384-well single-spot and MULTI-SPOT SECTOR plates (4-, 7-, and 10-spot plates). MSD plates are designed to be read only once and may not be reused.

3.4 System Components
A standard SECTOR S 600 system consists of the following (Figure 3:1):

- SECTOR S 600 instrument
- Microsoft Windows-compatible computer workstation
- MSD DISCOVERY WORKBENCH software
- MESO SECTOR Demonstration Plate
- Instrument Cables: AC power and USB
- Uninterruptible power supply (UPS)
- SECTOR S 600 Instrument Manual (supplied electronically on desktop)
- DISCOVERY WORKBENCH User Guide (supplied electronically on desktop)
3.5 The SECTOR S 600 Instrument

The main components of the SECTOR S 600 include (Figure 3:2):

- CCD camera and telecentric lens
- Motion control system
- Plate barcode readers (short and long side)
- Integrated MULTI-ARRAY plate input/output stack
- MULTI-ARRAY plate Stack Tubes (2, standard capacity, not shown)
- Single Plate Adapter (1, not shown)
- One Stacker Cover Plate (1, not shown)
- Instrument status LEDs
- Power switch and I/O panel (not shown)
- Motion Halt button (on some configurations)

Additional stack tubes, single plate adapters, and stacker cover plates may be purchased from MSD.
3.5.1 CCD Camera and Telecentric Lens

The SECTOR S 600 uses a sensitive, high-resolution CCD camera and lens system to detect light emitted from MULTI-ARRAY plates. The instrument reads plates using 6 sectors or segments, yielding higher throughput than comparable single-well detection systems.

Once the instrument is turned on and the software is started, it takes approximately 45 to 60 minutes for the CCD chip to reach and stabilize at its normal operating temperature of –35 ±1°C. The telecentric lens of the SECTOR S 600 provides high efficiency and uniform collection of light from MULTI-ARRAY plates.

3.5.2 Motion Control System

The SECTOR S 600 uses a precision mechanism for transporting MULTI-ARRAY plates from the input stacker, into the CCD camera’s viewing area, and back to either the input or output stacker, depending on selections in the DISCOVERY WORKBENCH Software. (See Section 6 Using the SECTOR S 600 for more information on reading a plate.)

3.5.3 Plate Barcode Readers

The SECTOR S 600 instrument’s two barcode readers read the barcode(s) on the MULTI-ARRAY plates. The MULTI-ARRAY plates come with an MSD barcode label that uniquely identifies the plate and allows the SECTOR S 600 to detect the type of plate being run.

If desired, the user may apply a custom barcode label either on the same side of the plate as the MSD barcode or on one of the short sides of the plate. The custom barcode label should be applied at the same height as the MSD barcode label. The custom barcode must be of one of the following formats: Code 39 or Code 128.
To enable custom barcodes, when the SECTOR S 600 reader window is open, go to Tools → Instrument Configuration. Select Enable Long-side Custom Bar Code Reader and/or Enable Short-side Custom Bar Code Reader.

Figure 3:3 Custom Barcode Reader Selection Dialog

![Custom Barcode Reader Selection Dialog]

Please contact MSD Scientific Support for additional information regarding the use of custom barcodes on MSD MULTI-ARRAY plates.

3.5.4 MULTI-ARRAY Plate Input/Output Stacker

SECTOR S 600 includes an integrated mechanism to manipulate multiple MULTI-ARRAY plates arranged vertically (referred to as the “stacker”). The stacker will automatically pull plates from the input (right) side and eject them into the output (left) side. The stacker may be used with two single plate adapters or two stack tubes or one of each. Stacker cover plates or single plate adapters containing an empty plate should be used over the stacker interface plates whenever the machine is not in use.

When running single plates, the input (right) stacker interface plate can act as both input and output ports. For safety, place a stacker cover plate over the left stacker interface plate when not in use.

⚠️ **WARNING:** The stacker contains components that may move at any time. Users of the SECTOR S 600 should never place their fingers into the stacker for any reason unless the instrument is powered off.

3.5.5 Stack Tubes

Stack Tubes allow the semi-automated processing of multiple plates in sequence. MSD offers standard-capacity (standard) and high capacity (extended) stack tubes (Table 3:1) for the SECTOR S 600. When using stack tubes, ensure that the single plate adapter has been removed and the stack tube is fully seated on the stacker interface plate (Figure 3:4). The standard tubes are provided with the SECTOR S 600, and both standard and extended tubes are separately available for purchase (Figure 3:5).

<table>
<thead>
<tr>
<th>Stack Tube</th>
<th>Plate Type</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard (Standard Capacity)</td>
<td>96-well MULTI-ARRAY</td>
<td>20 plates</td>
</tr>
<tr>
<td>Standard (Standard Capacity)</td>
<td>384-well MULTI-ARRAY</td>
<td>30 plates</td>
</tr>
<tr>
<td>Extended (High Capacity)</td>
<td>96-well MULTI-ARRAY</td>
<td>50 plates</td>
</tr>
<tr>
<td>Extended (High Capacity)</td>
<td>384-well MULTI-ARRAY</td>
<td>75 plates</td>
</tr>
</tbody>
</table>
Figure 3:4 Input (right) stacker interface plate

Figure 3:5 Fully loaded standard and high capacity stack tubes
3.5.6 Single Plate Adapter
The SECTOR S 600 has the ability to read single plates placed manually into a single plate adapter. When inserting the single plate adapter into the stacker, ensure that the adapter is fully seated on the stacker interface plate. Figure 3:6 (right side of image) shows a single plate properly loaded in the single plate adapter. The single plate adapter also allows use of the instrument with laboratory robotic systems.

3.5.7 Stacker Cover Plate
The stacker cover plate (Figure 3:6 left side of image) is used to cover the output (left) stacker interface when the machine is set to return single plates to the input side.

![Figure 3:6 SECTOR plate in single plate adapter](image)

**WARNING:** A stacker cover plate should always be in place when a stack tube or single plate adapter is not present. The stacker cover plate protects users from moving parts and protects the unused stacker area from dust and debris.
3.5.8 Status LEDs
The status LEDs built into the camera tower indicate the current operational mode of the SECTOR S 600 (Figure 3:7).

- **Steady blue**: Instrument is in standby mode
- **Blinking blue**: Instrument is currently reading a plate
- **Steady red**: Instrument is in fault mode or is waiting for the addition of plates

Figure 3:7 SECTOR S 600 status LEDs
3.5.9 Power Switch and Input/Output (I/O) Panel

The I/O panel of the SECTOR S 600, located on the rear right side of the SECTOR S 600, includes the instrument's power switch, fuse drawer, and connectors for power, USB and robotic halt activation cables (Figure 3:8).

The instrument can be powered-on and off via the power switch. Typically, the instrument should be left powered-on to maintain camera temperature.

**NOTE:** Only use the communications cables supplied with the SECTOR S 600. Use of cables other than those supplied may degrade instrument performance.

A halt connector is present in order to add an external switch that will de-energize the motion control system. The SECTOR S 600 connector receptacle is Hirose Electric Co Ltd HRS, Part #SR30-10R-4S. The mating connector is Hirose Part #SR30-10PE-4P, SR30-10PM-4P, or SR30-10PQ-4P.

![Figure 3:8 Power switch and I/O panel.](image-url)
3.5.10 Halt Button (on some configurations)

The halt button (Figure 3:9) is mounted on the front left side of the SECTOR S 600. This switch is on/off. If it is pressed for any reason, all motion will halt. It must be pressed again before the motion system and software will function. This button immediately de-energizes the main motion control components in the instrument. However, the remaining electronic components of the instrument remain powered and still pose a shock hazard.

⚠️ WARNING: The halt switch should never be obstructed or restricted from access.

The halt function can also be accessed through the rear I/O panel to enable external safety devices to halt the motion of the SECTOR S 600. Please contact MSD Scientific Support for more information on this feature.

Figure 3:9 SECTOR S 600 halt button (on some configurations)
3.6 Microsoft Windows-Compatible Workstations

Computer workstations are configured by MSD for use with the SECTOR S 600 and come preloaded with MSD DISCOVERY WORKBENCH application software (see Section 3.7 MSD DISCOVERY WORKBENCH Software). The workstation includes a personal computer, display, keyboard, and mouse. The instrument computer and its software are an integral part of the system, configured at the manufacturer, and should only be modified by an MSD Service Engineer.

I/O connections on the associated computer workstation are shown in Figure 3:10.

Figure 3:10 Cable attachment locations for SECTOR S 600

3.7 MSD DISCOVERY WORKBENCH Software

DISCOVERY WORKBENCH is a Windows application that supports the operation of the SECTOR S 600 instrument, stores both current and historical plate data, and analyzes and presents results. The application has several components: instrument modules, a secure database (the Plate Data History), kit layouts, data integrity features, and data analysis functions. Please refer to the DISCOVERY WORKBENCH User’s Guide for additional information.
3.8 Operational Modes

The SECTOR S 600 can be configured as a stand-alone workstation or integrated into robotic systems using the single plate adapter provided. The single plate adapter replaces the input stack tube and can serve as the load/unload location when using a robot for loading plates or when loading a single plate manually.

SECTOR S 600 has four operational modes:

- **The two-stack, stand-alone workstation mode** uses input and output stack tubes for loading and unloading.
- **The one-position, single plate handling mode** uses the single plate adapter in the input side for both loading and unloading single plates. The plate can be loaded either manually or by robotic plate handling equipment. In this mode, the stacker cover plate should be placed over the left stacker interface for safety (Figure 3:6).
- **The two-position, single plate handling mode** uses a single plate adapter on the input side for loading, and a second single plate adapter (if purchased) or stack tube on the output side for unloading.
- **The single-plate loading and stack-unloading mode** uses the single plate adapter on the input side for loading and a stack tube on the output side for unloading.

See Section 6.3 Robotics Integration for general information on robotic operational modes.

3.9 Image Readout

The SECTOR S 600 uses a CCD camera to obtain images of the plate during detection. One advantage of imaging detection is that the time required to read a plate is independent of the format of the plate (i.e., it is independent of the number of wells/plate or spots/well). SECTOR S 600 reads plates in sectors to improve sensitivity and optical detection efficiency. The instrument reads plates in 6 sectors at a rate of approximately 70 seconds per plate (Figure 3:11).

*Figure 3:11 The SECTOR S 600 reads 96-well plates in six sectors*
3.10 MESO SECTOR Demonstration Plate

Each SECTOR S 600 instrument is shipped with one demonstration plate. This demonstration plate verifies operation of the system and can be used for operational qualification (OQ). It does not verify performance qualification (PQ) and is not meant to be used for calibration purposes. It should be used to verify the function of the SECTOR S 600 without the need for liquid reagents. The demonstration plate consists of an electronic circuit board housed in a plastic carrier in the shape of a standard plate. The circuit board for the SECTOR S 600 has six separate sectors, simulating the structure of MSD MULTI-ARRAY plates (Figure 3:12) as read by the SECTOR S 600.

Figure 3:12 MESO SECTOR Demonstration Plate

For the SECTOR S 600, sectors 3 and 4 (Figure 3:11) of the demonstration plate have LEDs that test the CCD camera in the instrument. The remaining four sectors of the plate contain known electronic components for testing the electrical functioning of the instrument across its range of operation. The demonstration plate can be used without any chemical reagents, either to check instrument function at the start of each day or as a tool for demonstrating the instrument and software to new users.

Store the demonstration plate in its custom case when not in use, and keep the demonstration plate clean and free of dust and debris.
To use, place the demonstration plate in the single plate adapter with the chamfered corners of the plate facing into the instrument (Figure 3:13). This orientation ensures that the bar code reader can automatically read the bar code label. See Section 5 Quick Start for more details.

**Figure 3:13 Loading a demonstration plate**

### 3.11 Uninterruptible Power Supply

The SECTOR S 600 should be operated with an uninterruptible power supply (UPS) to ensure the integrity of data in the event of power line transients.

The UPS required will depend on the standard operating voltage at your laboratory's location. Please ensure that the proper UPS is employed for the power conditions in your country and local area.

⚠️ **CAUTION:** To avoid interference from voltage transients, the computer and instrument should be powered by the same electrical circuit. This can be accomplished by plugging the computer and the instrument into the battery backup outlets on the uninterruptible power supply (UPS) supplied with the instrument. Please contact MSD Scientific Support if you have questions or need assistance.
Installation
4 Installation

A qualified MSD Service Engineer must install and configure the SECTOR S 600 before use. Installation includes setup, connection of the instrument to its computer system, and verification that the instrument is functioning properly. Only the computer provided with the instrument and configured by an MSD Service Engineer should be used to operate the SECTOR S 600.

⚠️ **CAUTION:** Installation of additional software on the computer system used to operate the SECTOR S 600 is not supported. Specifically, updating aspects of the operating system or installing any software that changes parameters of the computer environment could interfere with proper operation of the instrument software.

⚠️ **CAUTION:** Running screen-savers, maintenance software, network-security software, and possibly other software on the SECTOR S 600 computer could cause conflicts with the operation of the instrument software.

⚠️ **CAUTION:** Use of other applications while plates are being read may interfere with system performance. Use of operating system power features that disable USB communication, such as Hibernate or Sleep, will cause the system to stop responding.

⚠️ **WARNING:** The instrument must be located in a position where the rear power switch and power input connector are accessible.

⚠️ **CAUTION:** Only mains power supply cords with a 10A or higher current rating can be used.

MSD Instrument Service should be consulted prior to moving the instrument.
Quick Start
5 Quick Start

This chapter will guide you through running the MESO SECTOR demonstration plate and verifying that the instrument acquires data and functions properly. Running the MESO SECTOR demonstration plate at the start of each day may be part of standard operation.

The SECTOR S 600 has a cooled CCD camera that needs to be brought to operating temperature before plates are read. To initiate the cooling process, the SECTOR S 600 must be turned on, the MSD DISCOVERY WORKBENCH software must be started, and the SECTOR S 600 Tools must be running (see steps 1–4 below). Simply turning on the instrument will not initiate CCD camera cooling. If the instrument has been off, allow at least 45 to 60 minutes for the CCD camera to cool when restarting. Operating temperature of -35 ±1°C must be reached before the DISCOVERY WORKBENCH software will allow the processing of any plates.

The Status window displays the temperature of the CCD camera while it is cooling (Figure 5:1). Once the CCD camera has reached its operating temperature, the temperature indicator will disappear, indicating that the instrument is ready for use. (The status window is accessible by selecting Tools from the menu bar in the DISCOVERY WORKBENCH software.)

**NOTE:** If the SECTOR S 600 has been idle, but has not been shut down (i.e., is in standby mode), then the CCD camera will already be at the proper temperature, and users may skip to Section 5.2 Setup.

*Figure 5:1 Instrument Status window*
5.1 Start-up

To start the system:

1. Turn on the SECTOR S 600 and the computer connected to it. If a robot is connected, the startup sequence is SECTOR S 600, then the robot, then the computer.

2. Log on to the Windows operating system. To do this, enter Administrator as the user login name and MsdAdmin as the password. (This is the default login shipped with the system; you may change this login/password or add additional Windows user accounts.)

3. If DISCOVERY WORKBENCH does not start automatically, double-click the MSD DISCOVERY WORKBENCH icon on the Windows desktop (Figure 5:2).

4. Click the instrument icon (Figure 5:3) on the toolbar to connect to the reader and initiate the CCD camera cooling process.
5. The SECTOR S 600 splash screen (Figure 5:4) will display while the instrument is initializing. If the instrument has just been powered-up, the cooling process will take approximately 45 to 60 minutes.

![MSD DISCOVERY WORKBENCH splash screen](image)

**Figure 5:4: MSD DISCOVERY WORKBENCH splash screen**

5.2 Setup

On the left side of the SECTOR S 600 window, users can view and edit the Setup selections for the demonstration plate read (Figure 5:5).

1. Select Read from Bar Code from the Plate Type menu.

2. Select the Return Plates to Input Stack checkbox. If left unchecked, the demonstration plate will be placed in the output stack on the left side of the SECTOR S 600 after reading. Because the demonstration plate will be run as a single plate, it is most convenient to return it to the input stack after processing.

   **NOTE:** It is very important to select Return Plates to Input Stack checkbox when the stacker cover plate is on the output stack so that the SECTOR S 600 will not attempt to place the plate into the covered interface at the end of the read.

3. Leave the Apply Kit Layout box unchecked. This option is covered in DISCOVERY WORKBENCH User's Guide.
4. Select the Read __ Plate(s) checkbox and enter 1 in the text field.

Figure 5:5 SECTOR S 600 Window: Setup, Plate Summary, and Operations areas

5. Place the single plate adapter on the input (right) stacker interface plate (Figure 5:6).

Figure 5:6 Stacker cover over the output port with empty single plate adapter in the input port
6. Place the demonstration plate in the single plate adapter with the chamfered corners of the plate facing into the instrument (Figure 5:7).

**Figure 5:7 MESO SECTOR demonstration plate in the single plate adapter**

NOTE: If the SECTOR S 600 is unable to read the barcode on the demonstration plate (or if no barcode label is present), the plate will be skipped and ejected from the instrument. Please contact MSD Scientific Support for assistance.

5.3 Run

When the camera reaches proper operating temperature, the Instrument Log (click Show Log in the Status window) will indicate that the temperature is locked. At that point, the instrument is ready.

Click Run in the SECTOR S 600 window. The Run Options dialog window will open (Figure 5:8).

1. Verify Setup Selections. If changes are necessary, click Cancel, make changes in the area (5.2 Setup) of the SECTOR S 600 window, and re-verify Setup Selections.

2. Run name is optional, but one can be entered in the second section.

3. Verify the Export information and make changes if necessary. (Refer to the DISCOVERY WORKBENCH User’s Guide for additional details.) The export selections control the format and the location of the exported text data file that will be created when the demonstration plate is read.

4. Click OK. The plate read starts. View the status in the lower left region (Status bar) of the DISCOVERY WORKBENCH software to monitor progress. When the plate read is complete, the demonstration plate is returned to the stacker and Run is enabled again.
5.3.1 Operations

The Pause, Stop, Eject, and Retract buttons operate the motion control system that moves plates through the instrument.

- **Pause.** Pauses the plate read. Selecting Pause again resumes the read.
- **Stop.** Stops the current run and ejects any plate inside the instrument.
- **Eject.** Transfers a plate from inside the instrument (but not being read) to the stacker output port where it may be retrieved. This function is disabled during a plate run.
- **Retract.** Lowers the stacker mechanism if needed and then ensures the instrument door is closed. Any plates in the input location will remain where they are. No further action is taken without input from the operator. This function is disabled during a plate run.

![Figure 5.8 SECTOR S 600 window, Run Options dialog box](image-url)
5.4 Results

The software provides several options for viewing results. Select View → Layer Views from the menu or select a layer from the Layer menu on the toolbar. Refer to the DISCOVERY WORKBENCH User’s Guide for details on data viewing options. If you observe the data as it is acquired in Color Map view, bright wells should display numbers above 2000 and dark wells should display numbers below 200.

Figure 5:9 shows a Color Map view of the data from the demonstration plate. The values shown in this figure will differ slightly each time the plate is read. This behavior is expected.

![Figure 5:9 Demonstration plate results, Color Map layer](image)

When using the MESO SECTOR demonstration plate, sectors 3 and 4 (Figure 3:11) should display four bright wells each, as shown in Figure 5:9. Sectors 1, 2, 5, and 6 should have uniform, low signal levels corresponding to instrument background.
Using the SECTOR S 600
6 Using the SECTOR S 600

This chapter explains how to prepare and load single or multiple MULTI-ARRAY plates for typical use with the SECTOR S 600. Additional information is provided to integrate the instrument with an external, third-party robotic system. Please refer to the DISCOVERY WORKBENCH User’s Guide for detailed instructions on running MULTI-ARRAY plates on the SECTOR S 600 system.

NOTE: This section assumes that a qualified MSD Service Engineer has installed and configured the instrument, and that the user has run a demonstration plate as described in the previous section.

6.1 Single Plate Run

To run a single MULTI-ARRAY plate, place the single plate adapter in the (right) stacker interface.

The right stacker interface can act as both input and output locations. If not using the output (left) interface, place the stacker cover plate over it. The SECTOR S 600 will pull and eject plates from/to the input (right) interface.

If using the output side, install a second single plate adapter or a stack tube on the output (left) stacker interface plate. The SECTOR S 600 will automatically pull plates from the right side and eject plates into the left side.

If the stacker cover plate is present on the output stack, remember to select the Return Plates to Input Stack checkbox so that the SECTOR S 600 will not attempt to place the plate into the covered stack at the end of the read.

Prepare the MULTI-ARRAY plate using the required reagents per the assay protocol. Place the plate into the single plate adapter. Sensors within the instrument will automatically identify the plate orientation and compensate the data acquisition and analysis accordingly. Per the detailed instructions in the DISCOVERY WORKBENCH User’s Guide, configure the options in DISCOVERY WORKBENCH and run the plate.

6.2 Stack Run—Multiple Plates

Multiple plates may be loaded into SECTOR S 600 instrument using the standard or high-capacity stack tubes (Figure 3:5). SECTOR S 600 reads plates from the bottom of the stack tube.

6.2.1 Loading the Stack Tube

Prepare MULTI-ARRAY plates using the required reagents per the assay protocol.

To load prepared plates into the stack tube:

1. Stack plates on a stable surface.

2. Place the stack of plates on top of an extra, standard 96-well MULTI-ARRAY plate. This extra plate serves as a spacer for loading (Figure 6:1).

3. Orient the stack tube so that the corners of the plates are toward the back of the instrument.
NOTE: A label on the inside of the stack tube reminds users of the correct orientation for loading plates. The stack tube itself will only fit on the interface plate in one orientation.

4. Slide the stack tube carefully over the top of the stack of plates such that the plates slide into the tube. Once the stack tube base is flush with the stable surface, all but the extra plate will be loaded into the stack tube (Figure 6:1).

5. Remove the single plate adapter if it is present on the stacker.

6. Place the full stack tube on the input (right) stacker interface plate.

7. Place an empty stack tube of the same size on the output (left) stacker interface plate.

Figure 6:1 Loading MULTI-ARRAY plates into stack tube

If the stack of plates to be run is too tall for the above procedure, you can insert the additional plates through the top of the stack tube (up to the stack tube capacity) during the run. Be careful to not to add more plates than can be accommodated in the output stack tube.

⚠️ CAUTION: When reading multiple plates in a run, ensure that the stack tube is not overloaded. See Table 3:1 Stack Tube plate capacities.

⚠️ WARNING: Loading a tall stack of plates could lead to spilling potentially harmful chemical reagents. Use caution when loading the stack tubes.
6.2.2 Unloading the Stack Tube
After running a stack of plates, the consumed plates will be located in the output stack tube. These plates should be unloaded and properly disposed of prior to running additional plate stacks to prevent the possibility of overfilling the output stack tube.

⚠️ **CAUTION:** Not removing the completed plates from the output stack may cause spills if the number of completed plates exceeds the capacity of the output stack.

The plates should be removed manually by sliding them up and out the top of the stack tube. The last few plates can be accessed by pushing the last plate up from the bottom of the stack tube.

6.3 Robotics Integration
The SECTOR S 600 instrument can be integrated with a robotics system for loading and unloading plates using the Remote Instrument Mode, which allows the instrument to be used as a component through its remote interface. A Remote Instrument Manual that provides descriptions of the commands recognized by the MSD software is available upon request. Contact Scientific Support for more information on robotics integration.
Maintenance
7 Maintenance

This chapter contains basic maintenance instructions for the SECTOR S 600 and some components. A qualified MSD Service Engineer should perform all other maintenance procedures not described in this section.

⚠️ WARNING: Opening the instrument to perform maintenance incurs risk of mechanical and electrical harm.

The SECTOR S 600 instrument requires proper care, including occasional preventive maintenance. Only MSD Service Engineers should perform standard preventive maintenance on the instrument. The schedule for these procedures depends on the usage of the instrument.

Please perform periodic system maintenance on the computer in order to maintain high performance. This includes running the defragmentation program included with the operating system on a regular basis. A performance qualification kit containing plates, reagents, and a protocol for verifying instrument performance, is available for purchase (MSD catalog #R31QQ-3). MSD Scientific Support can provide more details on the performance qualification kit.

Inspect the SECTOR S 600 before and after each use to ensure that there is no debris (liquid, dirt, plastic items, etc.) on or near the stacker interface plate. Clean the SECTOR S 600 after each use as described below.

7.1 Preventive Maintenance

Scheduled maintenance should include the cleaning and lubrication of all appropriate internal components. Only MSD Service Engineers should perform this maintenance, usually once every 6 months.

Contact MSD Customer Service to ask about our service contracts.

7.2 Instrument Cleaning

Reasonable care should be taken to prevent unnecessary fluid spills onto and into the SECTOR S 600. Any spills onto the instrument should be promptly cleaned using either water, 70% ethanol, 1% bleach in water, or a mild detergent. Choose a cleaning solvent that is appropriate for the nature of the spill. Lint-free cleaning wipes are recommended for this cleaning.

⚠️ CAUTION: The instrument should be turned off and unplugged for all cleaning processes.

Any of the outside surfaces of the SECTOR S 600 can be cleaned. In addition, accessible regions of the stackers and elevators can be cleaned. The stackers should only be cleaned when the power is disconnected.

⚠️ WARNING: When the stack tubes are removed, the plate elevator and doors to the instrument pose a pinch hazard. Do not put hands into these regions while the instrument is powered-up.

If chemical reagents are spilled on the plate loading area, wipe off the silver lift plate. Make sure to wipe off the rectangular sensors at the front and rear notches of the silver lift plate.

If chemical reagents are spilled inside the light tight enclosure of the SECTOR S 600, contact MSD Instrument Service for instructions.
7.2.1 Adapter and Stack Tube Cleaning
Spills on single plate adapters or stack tubes should be promptly cleaned to prevent a build-up of crystalline debris or dried salts that could interfere with their operation. In particular, plates may not load correctly if the latch movement of these devices is compromised.

Clean dirty latch mechanisms by soaking the latches in warm water (approximately 104°F/40°C) with a small amount of residue-free detergent for 15 minutes. Rinse the latches thoroughly with running water, tip and/or shake gently to remove excess liquid, and allow to fully air dry. If there is any residue remaining, soak the latches in a 70% alcohol solution (isopropanol or ethanol in water) for 15 minutes; shake out the excess, and allow to air dry completely. If plate-loading problems persist, contact Scientific Support.

7.3 Instrument Decontamination
Contact MSD Scientific Support for a detailed protocol for instrument decontamination.

**NOTE:** The SECTOR S 600 must be decontaminated prior to shipping the instrument back to MSD. Contact MSD Scientific Support prior to shipping for instructions and requirements.
Appendix
8 Appendix

8.1 Troubleshooting Guide

Refer to Table 8.1 below to troubleshoot hardware and operating errors. The software version may be found in Help ➔ About Workbench.

Table 8.1 Troubleshooting guide

<table>
<thead>
<tr>
<th>Symptom/Error message on screen</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument or computer does not power on.</td>
<td>Loose or disconnected power cable(s)</td>
<td>Ensure that the cables connecting the instrument and/or computer to the external power source are plugged in properly.</td>
</tr>
<tr>
<td></td>
<td>No voltage at outlet</td>
<td>Test the outlet by connecting a different electrical device to the outlet.</td>
</tr>
<tr>
<td></td>
<td>One or more fuses activated</td>
<td>Fuse specifications for the instrument are shown in Section 8.2.4: Power Requirements.</td>
</tr>
<tr>
<td>The plate passes through the instrument without being read. The status window jumps from 1% to 100%.</td>
<td>The instrument was unable to read the barcode on the plate. The bar code may be damaged, smudged, marked, or otherwise unreadable.</td>
<td>Verify a bar code is smoothly affixed to the side of the plate. Then, select the appropriate plate type from the pull-down menu, and read the plate again. If the barcode is damaged, reverse the orientation of the plate so that the barcodes on the other side of the plate are read.</td>
</tr>
<tr>
<td>Error 515 General error The instrument failed to read the plate after clicking the Run button.</td>
<td>Windows security settings, networking parameters, or the instrument name has changed.</td>
<td>Click OK to continue. Determine whether your IT department has made any changes to the instrument computer recently.</td>
</tr>
<tr>
<td></td>
<td>Incompatible anti-virus software has been installed on the instrument computer.</td>
<td>Disable the antivirus program temporarily to see if that is the issue. There are several methods: 1) Exclude the file: C:\Program Files\MSD Discovery Workbench\lib\prefs.properties from scanning. 2) Disable real-time scanning. 3) Uninstall the antivirus program and use a different one.</td>
</tr>
<tr>
<td>Error 515 General error The instrument failed to initialize after clicking the instrument icon.</td>
<td>The Windows theme has changed.</td>
<td>Click OK to continue. Restore the default Windows theme. Please check whether your IT department has made any changes to the instrument computer recently. The sysinfo file contains a software log that can be used to diagnose the problem. See Section 9.2 below for instructions on creating a sysinfo file.</td>
</tr>
<tr>
<td>Error 515 General error The error was noted while reading a plate or during data analysis.</td>
<td>The Plate Data History (database) is full.</td>
<td>Click OK to continue. Backup and clear the database. For DISCOVERY WORKBENCH v4, instructions on backing up and clearing the database can be found in the DISCOVERY WORKBENCH User’s Guide. The software log will contain a message such as: Could not allocate space for object ‘PIDTable’...in database ‘LCPRSchema’ because the ‘PRIMARY’ filegroup is full.</td>
</tr>
<tr>
<td>Symptom/Error message on screen</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Error 6106 Instrument initialization failed | The instrument or computer has experienced a communications failure. | Perform the following steps:  
1) Shut down the computer  
2) Shut down the SECTOR S 600  
3) Restart the computer  
4) Restart the SECTOR S 600 |
| Error 7254 Hardware fault | A fault was detected in the camera or camera controller. This error can be caused by a blown fuse internal to the camera power supply, a fault with camera USB communication, or a disconnected cable. | Check that all connections are tight, particularly USB cables runs from the instrument to the back of the computer. If no loose cables can be found and the instrument still fails to function after restarting, contact Scientific Support for assistance. |
| Error 7461 Instrument not ready when starting a plate run. | The camera has not reached the proper temperature for operation. The SECTOR S 600 camera will cool to -35°C, before the instrument becomes operational. | Check the camera cooling status (Tools → Status) The temperature should be dropping toward the operating temperature. Wait up to 60 minutes for the camera to stabilize at the correct temperature. This is a normal function of turning on the instrument. Restart the software. Check the temperature again. Contact Scientific Support if the camera temperature is not dropping. |
| Error 8704 The SQL Server (MESOSCALE2) service has not started | The Windows service has not started. | It may take up to 5 minutes for this service to start after the computer is started. If the error is caused because DISCOVERY WORKBENCH was launched before the service started, then restarting the software will resolve it. If the service has been interrupted, it must be restarted. This can be accomplished by restarting Windows, or the service can be manually restarted as follows:  
1) Right-click My Computer on the desktop and select Manage. In the Computer Management window under Services and Applications, click Services.  
2) In the alphabetical list of services, right-click SQL Server (MESOSCALE2) and select Restart. |
<p>| Error 8906 Invalid Plate Type | A discontinued plate or a plate configuration exclusive to another instrument was used. | Discontinued plates cannot be run. In addition, plates made for other MSD instruments may be incompatible with the SECTOR S 600 instruments. |
| Error 9460 Instrument timed out | Communication between the instrument and the computer has been interrupted. | Check the cables attached to the instrument and computer to make sure they are correct and seated securely. If all cables are properly connected, contact Scientific Support. The sysinfo file contains a software log that can be used to diagnose the problem. See Section 9.2 below for instructions on creating a sysinfo file. |
| Error 9711 Unable to connect to the instrument server | Loose cables prevent communication between the instrument and computer. | Check the integrity of all cables going into the SECTOR instrument and the desktop computer. |
|                                  | Communication between the instrument and computer has been interrupted. | Restart the computer and then check that the SQL Server Service has started. To do so, navigate to the Control Panel and open Administrative Tools → Services. Scroll down to the service named SQL Server (MESOSCALE2) and check that the status is started. If the service is not started, right-click the service and select All Tasks → Start. If the option to start the service is disabled, log in to Windows as an administrator, and try to start the service. |</p>
<table>
<thead>
<tr>
<th>Symptom/Error message on screen</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| Error 9901, 9902, Communications failure | The instrument lost communication with the computer. | Ensure that both the instrument and computer are powered on and all power and communications cables are connected and secure. Close DISCOVERY WORKBENCH and restart the computer. If restarting does not correct the problem, then switch the location of the instrument-to-computer USB cable by plugging the USB cable into a different USB port on the instrument computer.  
  1) Turn off the SECTOR S 600.  
  2) Wait 30 seconds.  
  3) Turn on the SECTOR S 600.  
  4) Restart the computer.  
  5) Wait five minutes before starting the MSD DISCOVERY WORKBENCH software.  
If the problem is not resolved, contact Scientific Support. |
8.2 Specifications

8.2.1 SECTOR S 600

NOTE: All performance information including standard signal levels, detection limits, dynamic range, and instrument noise is based on 150 µL read volumes in 96-well MULTI-ARRAY plates using standard plate read parameters.

8.2.2 Scientific Performance

Table 8.2 Scientific performance

<table>
<thead>
<tr>
<th></th>
<th>SECTOR S 600</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Signal Levels</strong></td>
<td></td>
</tr>
<tr>
<td>Signals generated by Free TAG, 15,000 [Cat # R31QQ-3]</td>
<td>12,000–18,000 counts</td>
</tr>
<tr>
<td>Signals generated by PQ Low Control [Cat # R31QQ-3]</td>
<td>25–100 counts</td>
</tr>
<tr>
<td><strong>Dynamic Range</strong></td>
<td>10^6</td>
</tr>
<tr>
<td><strong>Electronic Noise</strong></td>
<td>≤ 16 counts</td>
</tr>
<tr>
<td>Standard Deviation Dark Noise (one spot plates)</td>
<td></td>
</tr>
</tbody>
</table>

8.2.3 Environmental Specifications

Operational Temperature Range 20–26 °C (68–78 °F)
Operational Humidity Range 10–80% non-condensing
Storage Temperature Range 5–40°C (41–104 °F)
Storage Humidity Range 5–85% non-condensing
Ambient Light < 2000 Lux

8.2.4 Power Requirements

Voltage 100–240 V~ 50/60 Hz
Current 3.5A–2.8A @ 100–240 V~

Class I, Installation (Overvoltage) Category II Device

⚠️ Fuses

Electrical fuses are only accessible by MSD Service Engineers and are not user-serviceable. The information below is provided for reference.

Main Fuses F1 and F2:

T4.0 A, 250 V, 100–240 V~
8.2.5 SECTOR S 600 Physical Dimensions

- Instrument Size: 26.8 in x 30.5 in x 33.9 in (68.1 cm x 77.5 cm x 86.1 cm)
- Instrument Weight: 124 lbs (56 kg)
- Total Package Weight (2 boxes): 285 lbs (129 kg)

8.2.6 Plate Standard Read Volume (per Well)

- 96-well MULTI-ARRAY Plates: 150 µL
- 384-well, MULTI-ARRAY Plates: 40 µL

8.2.7 Custom Bar Code Compatibility*

- Code 39
- Code 128

*Contact MSD Scientific Support for information on proper label, font size, and location of custom bar code on plate. Recognition of additional codes is possible but has not been tested.

8.2.8 Plate Specifications

MSD MULTI-ARRAY and MULTI-SPOT plates are designed to comply with the mechanical dimensions of the proposed standards of the Society of Biomolecular Screening. Contact MSD Scientific Support for further details.

Technical Support
9 Technical Support

MSD provides excellent and timely support for all authorized users of SECTOR S 600. We welcome and carefully consider all bug reports and suggestions for improvements to future versions. We will work with you to resolve any problems you may encounter.

9.1 Bug Reports and Suggestions

Please send comments or feedback on the software, including bug reports, unresolved error codes, feature requests, or design change requests, to MSD Scientific Support at scientificsupport@mesoscale.com.

9.2 Problems Running SECTOR S 600 Instruments

If you encounter an error report that you cannot resolve, please provide us with as much of the following information as possible:

- The error code and text in the error dialog box
- What you were doing when the error occurred
- A description of how the error is reproduced
- If requested by MSD Scientific Support, a copy of the SysInfoOutput.txt file located in C:syssinfo

To generate the report file, first run the SysInfo.exe diagnostic tool as an administrator. A copy of the tool is located in (Win7-32 bit) C:\Program Files\MSD DISCOVERY WORKBENCH\bin. The instructions for running this tool are as follows:

1. Hold down the Shift key and right-click on the SysInfo.exe file.
2. Select “Run as administrator” and enter administrator credentials if requested.
3. Wait about 5 minutes to allow the tool to complete creating the file.
4. Browse to the C:syssinfo folder
5. Right click on the “SysInfoOutput.txt” file and choose “Send To > Compressed (zipped) folder”
6. Email the SysInfoOutput.zip file to MSD Scientific Support at scientificsupport@mesoscale.com.

Email this information to scientificsupport@mesoscale.com. Someone will contact you within two business days. If the error is affecting your work, please mark it URGENT and we will respond as quickly as possible.

9.3 How to Contact Us

Meso Scale Diagnostics, LLC., company headquarters is located at:

1601 Research Boulevard
Rockville, Maryland 20850 USA
+1 240-314-2600

Our website is www.mesoscale.com.

Customer Service
+1 240-314-2795
customerservice@mesoscale.com

Scientific Support
+1 240-314-2798
scientificsupport@mesoscale.com

Instrument Service
+1 301-947-2057
instrumentservice@mesoscale.com